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History 

 

Issue Date Description 

Issue 1.0a 2003.09 Initial Description 

Issue 1.0b 2003.10.23 Added about Log-view, information window. 

Issue 1.0c 2003.11.22 Unscreened transfer, SMS to GSM Modem function added. Search option, 

trace save option function added. 

Issue 1.0d 2004.01.31 Use of ms-outlook schedule. 

Issue 1.0e 2004.03.22 Recall History, Display stations by ascending logical number, small button 

type. 

Issue 2.0a 2004.4.16 

 

Scheduler auto loading time interval, log view delete, speed bin data for 

600 hotel, scrolling station list, phonebook list when find matched item, 

group call window display, co line display window , hot desk function. 

Issue 2.0b 2004.9.15 Sorting station buttons by logical number/user name, Prepaid call function, 

Display selected stations, CO line outgoing disable/enable, Account code 

Wake Up/Recorder Icon Selection. 

Issue 2.0c 2004.11.17 LDK-20 system added, co line drop function 

Issue 2.0d 2004.12.03 GSM modem usage in Appendix 

Issue 2.0e 2005.01.10 Conference Room Manager 

Issue 2.0f 2005.03.15 Make it possible to logon either IP-LDK system or iPECS system 

Issue 2.0g 2005.12.07 CI is changed 

Issue 2.0h 2006.04.14 ARIA SOHO system is added 

Issue 2.0i 2006.08.17 LDK-60 system, Fixed Line SMS function added 

Issue 2.0j 2006.09.29 STATION name restriction 

Issue 2.0k 2007.02.22 The documents for general Call Servers and iPECs were integrated into 

one. 

Issue 2.0l 2007.11.28 My status dialog box‟s been changed because lunch time‟s added. 

Issue 2.0m 2008.02.22 The explanation for some feautes were corrected. 

Issue 2.0n 2008.09.19 User guide is unified to on(GSNAT) 

Issue 2.0o 2008.12.08 Outlook pop-up setting‟s been add on Customized Dialog, drag&drop 

function for queued call‟s been added. 

Issue.2.0r 2009.09.02 Appendix F‟s been added for DN numbers in MG systems. 

Issue.2.0s 2010.06.30 CI changed from LG-Nortel to LG-ERICSSON 

Issue.2.0t 2010.09.07 Added Auto Start and Auto Logon function  

Authorization code function is added 
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Issue. 2.0t 2010.11.23 “iPECS 1200” system‟s been added. 

Issue. 2.0u 2011.04.15 “Use 8 digits” is added 

Hotel Suite Room function and room status are added 
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LG-Ericsson reserves the right to make changes to the specifications and other information in 

this document at any time and without prior notice.  While the information furnished in this 

document is believed to be reliable and accurate, LG-ERICSSON  makes no warranty express 

or implied that it is true and accurate in all cases. 

 

 

Need general trademark & copyright statement here for LG, MS and perhaps Intel. 
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1 Introduction 
 

This document provides installation and user operating instructions for the LG-Ericsson ez-

Attendant PC based software application.  The document includes an overview of ez-Attendant, 

as well as detailed directions for installation of the ez-Attendant application in a PC, connecting 

the PC to the host LG- Ericsson telephone system and an operational guide for the ez-Attendant 

user. 

 

Several terms used in this manual are defined below for clarity: 

 Select:  with the mouse, move pointer to object and click on the left button of the mouse, 

 Enter:  type the input, characters or digits, using the keyboard or in the Keypad window, 

click on digits with the mouse.  

 Call Server: LG-Ericsson telephone system. 
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2 Overview 
 

ez-Attendant is a software application designed to enhance the attendant functionality of the Call 

Server by visualizing the Attendant call handling and control functions.  ez-Attendant works in 

conjunction with the Attendant‟s multi-button phone providing enhanced attendant functionality 

and efficiency.  The user interfaces with the ez-Attendant screen, Figure 2, using the mouse 

(point and click) or programmable „Hot Keys‟ to select features and functions available.  A 

pop-up Incoming Call window notifies the user of incoming calls while working with other 

applications (word processor, spread sheet, etc.). When user doubleclick on the task bar of 

ezAttendant, it can do former operation. 

 

ez-Attendant incorporates a database for internal users and external contacts and shares the 

System Speed Dial data with the Call Server.  The database entries can be searched and used to 

place calls.  The external contact database can be linked to a private or shared PIM (Personal 

Information Management) database including Outlook, Goldmine or ACT!.  Also schedules of 

internal extension users in public Outlook files can be shared with and displayed on the ez-

Attendant screen. 

Figure 2 ez-Attendant Screen 
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3 Installation 
 

Installation is a 3 step process; install the ez-Attendant application in the desired PC, configure 

ez-Attendant and connect the ez-Attendant PC to the host Call Server.  Note that after 

configuring ez-Attendant, the ez-Attendant PC should be restarted to assure all configuration 

information is available in active memory. 

 

3.1 PC Requirements 
 

The ez-Attendant application software requires a PC with the recommended configuration 

defined below: 

Table 3.1 Hardware Requirements 

ITEM REQUIREMENT REMARK 

Call Server System ipLDK, iPECS, iPECS-MG systems DKTU, SLT, DECT(GDC-345) 

Operating System Windows-based Windows 2000, Windows XP 

Windows Vista, Windows 7 

Processor(recommended) Pentium IV, 2GHz  

RAM 512MB  

Video Card SVGA  

Network Interface Card 10/100 Base T  

Computer Accessories CD-ROM drive, Keyboard, mouse  

Hard Disk Space 100MB  

Call Server Connection Each system should have LAN port  

 

3.2 Host Telephone System 
 

ez-Attendant is designed to work with the Call Server which must be equipped with a LAN port 

for connection to the ez-Attendant.  ez-Attendant is compatible with all Call Servers below: 

 ARIA SOHO, LAN port is standard 

 ARIA SOHO IP, LAN port is standard 

 IP LDK-60,LAN port is standard 

 IP LDK 50 with LAN option board 

 IP LDK 100 with LAN option board 

 IP LDK 300, LAN port is standard 

 IP LDK 600, LAN port is standard 

 iPECS 100, LAN port is standard 

 iPECS 300, LAN port is standard 

 iPECS 600, LAN port is standard 
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 iPECS 50A, LAN port is standard 

 iPECS 50B, LAN port is standard 

 iPECS-MG 300 

 iPECS-MG 100 

 iPECS 1200 

 

The Call Server MPB (Main Processor Board) must be equipped with the software version 

3.7Aa or later.  In case of iPECS systems, the MFIM must be 3.0Al or later. In addition, the 

Call Server must have a fixed (static) IP address.  For security purposes, a private IP address is 

recommended.  The ez-Attendant PC will support static or dynamic IP addressing. 

 

ez-Attendant will operate in a networked environment where several Call Servers are 

interconnected.  In the networked environment, the BLF Manager server, which runs on a 

separate PC, provides status information on up to 50 extensions of each network node to ez-

Attendant. 

 

3.3 ez-Attendant Application Installation 
 

The ez-Attendant application is installed on the PC using the supplied CD.  Installation uses an 

Auto Run program that will start when the CD is placed in the PC‟s CD ROM drive.  Once 

started, the InstallShield Wizard, Figure 3.3a,  

Figure 3.3a  ez-Attendant Wizard 
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Click Next; the install progress screen will appear followed by the install complete screen, 

Figure 3.3b. 

Figure 3.3b ez-Attendant Install Complete 

 

Click Finish, and the windows desk top will appear with the ez-Attendant short-cut on the 

Windows desk top, circled in red in Figure 3.3c. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.3c  ez-Attendant Short-cut 



ez-Attendant Issue 2.0u 

 

 4 8-Jul-10 

 

Once completed, the ez-Attendant is operational; however, for proper communication with the 

Call Server, it is necessary to install a “software lock-key” in the host Call Server system.  For 

instructions regarding Lock-key installation, refer to the Call Server‟s Lock-key installation 

guide. This Lock-Key installation guide is included in the Call Server‟s manual. 

 

3.4 ez-Attendant Configuration 
 

There are several mandatory configuration items, which must be input to ez-Attendant for 

proper operation.  Specifically, the IP address of the host Call Server‟s LAN port and the 

Attendant extension number must be properly set.  These items as well as a number of other 

configuration items are set in the tabbed pair of windows, Display and Settings, Figures 3.4a and 

3.4b.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Figure 3.4a Display Window 
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Figure 3.4b Setting Window 

 

As shown, these windows are divided into sections for various characteristics which are 

described in the following paragraphs in the order displayed above.  Additional configuration 

items from other dialog boxes are also covered in this section. 

 

3.4.1 Display Window 
 

3.4.1.1 Station Type and Window Size 
 

The Station Window in the ez-Attendant main screen is intended primarily for use as a status 

display of the host and, if assigned, the networked Call Server‟s stations.  Note that the Station 

Window is also used to display the ez-Attendant Phone Book and to view call logs by selecting 

the appropriate tab to the right of the window.  When used in the Station Field view, the display 

indicates the status of internal stations and allows the Attendant to call individual stations by 

selecting the desired station button. 

 

For convenience, under the Station Field tab, the stations can be displayed in one of three 

„Types‟ or views: Large Icon button, Small Icon button and List view, Figure 3.4.1.1a.  In the 

Large Icon view each station is displayed with the station name and number and a phone Icon 

which is used to indicate status of the extension. The Small Icon view displays the station 

number and a smaller phone Icon, again used to indicate extension status.  In the List view, 

extensions are shown in a simple list with the name, number and other user related phone 
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numbers as well as the small phone Icon for status. 

 

 

Figure 3.4.1.1a Station Button and List view display 

 

The size of the Station Window can be adjusted for Small, Medium or Large to increase the 

number of button rows or list items displayed.  The number of rows displayed is based on the 

Window size and Type selected as in Table 3.4.1.1 below for the default resolution (1024 by 768 

XGA).  In both the Large and Small Icon view seven columns of icons are displayed. 

Table 3.4.1.1 Station Window Size 

Window 

Size 

Displayed Rows/buttons 

Large Icon Small Icon List 

Small 4/28 8/56 13 

Middle 5/35 10/70 18 

Large 6/42 12/84 21 

  

The view and size are configured in the Station Type and Station Window Size sections of the 

Display Window, Figure 3.4.1.1b.  To access these sections of the Display Window; 

 select Setting from the Menu bar, 

 select Option from the Setting Menu, 

 select the Display tab from the Display and Settings Window. 

 

Click on the „radio button‟ for the view desired; for a Large Icon display select Button Type, for 

the Small Icon display select Small Button Type and for the List display select List Type.  For 
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the Station Window Size select the radio button desired, Small, Middle or Large.  Refer to 

Table 3.4.1.1 for the number of rows that will be displayed for each selection.  Select Apply 

which will save the selection and allow further entries or OK which will save the selection and 

return to the ez-Attendant main screen. 

 

Figure 3.4.1.1b Station Window Display Mode 

Notes: 

 As the size of the Station Window is increased, the size of the System Text Message, 

Schedule and SMS (Short Message Service) windows will be decreased. 

 For iPECS-MG system, ez Attendant supports DN list and please refer to the Appendix F 

for detail information. 

 

3.4.1.2 Station View 
 

The Station Window displays stations by groups.  The active group display is selected from the 

tabs at the top of the Station Window.  Groups available are based on the group (department) 

name in the internal Phone Book or a single group of “selected stations”.  The user can select to 

view stations by group name or by selected station.  Selecting View by Group name, will 

display stations by the department name registered on the Phone Book, refer to section 3.4.2.5 to 

add/edit Group names members.  Choosing View by selected stations, the ez-Attendant 

displays stations selected by user as below. 

 

To display selected stations; 

 select Setting from the Main Menu, 

 select Option from the Setting Menu, 

 select the Display tab from the Display and Settings Window, 

 click the radio button with View by Selected stations text to display selected stations, 

 

 

 

Figure 3.4.1.2a station view tab 

 

After selecting View by Select Station, stations can then be assigned to the selected stations 

group. 
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To select stations for monitoring; 

 select Setting from the Main Menu, 

 select Selected Station View from the Setting Menu ,Figure 3.4.1.2b, 

 select stations for monitoring and select      , 

 Select the Close button to store the selection and exit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.4.1.2b Select station window 

When complete, the Station Window will display the “ALL Group” and “Selected Stations” tabs 

as shown in Figure 3.4.1.2c and will not display stations by the Group(department)name. 

 

 

 

 

  

 

 

 

Figure 3.4.1.2c Select station view 
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3.4.1.3 Button View Number/Name Sort 
 

When the Button Type view is selected, the buttons can be displayed sorted by extension number 

or names.  When sorted by number, the lowest station number is shown in the upper left and 

the highest is shown in the lower right, Figure 3.4.1.3a.  When sorted by name, the buttons are 

sorted in the alphabetic order of the first name as shown in Figure 3.4.1.3b.  To change the 

sorting option; 

 Right click using the mouse with the pointer in the Station Window, 

 Click Sort By name or Sort By Number. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.4.1.3a Popup Menu on the station window 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.4.1.3b Station window sorted by name 

Notes: 
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The default sort order is by Number.. 

 

3.4.1.4 Station Name Display 

The Station Name Display Type has two types. First one is display by Phonebook‟s name. Users 

register directory information for internal user on Phonebook. After connected to the system, ez 

Attendant displays user‟s full name registered on Phonebook as directory. The other is display 

by system‟s name. If system administrator registered name for each station, ez Attendant gathers 

those information during login process. And user can see station‟s name registered in the system. 

To access this section; 

 Select Setting from the Menu bar. 

 Select Option from the Setting menu. 

 Select the Display tab from the Display and Settings Window. 

 

 

 

 

Figure 3.4.1.4 Station Name Display Type 

Click the desired „radio button‟ to select display by Phonebook‟s name or System‟s name. 

 

3.4.1.5 Call Park Display 
 

The Call Park Window displays information on calls that are “parked” by ez-Attendant.  

Included information is the Park Zone and the caller Id for the parked call.  The window will be 

shown just above the Lower Tool bar.  As a default the Call Park Window is not displayed.  

ez-Attendant may be configured to show this window from the Park Call Display section in the 

Display Window, Figure 3.4.1.5.  To access this section; 

 select Setting from the Menu bar, 

 select Option from the Setting menu 

 select the Display tab from the Display and Settings Windows. 

 

Click the desired „radio button‟ to select Show or Hide the Call Park Window. Select Apply 

which will save the selection and allow further entries or OK which will save the selection and 

return to the ez-Attendant main screen. 

 

 

 

Figure 3.4.1.5 Park Call Display 
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3.4.1.6 Keypad Display 
 

ez-Attendant can display a „telephone keypad” which the attendant can use to place internal or 

external calls in place of the Attendant‟s multi-button phone.  The keypad can be displayed in 

either the Information or Queue Window based on the option selected in the Keypad Display 

section of the Display Window, Figure 3.4.1.6.  To access the Keypad Display section; 

 select Setting from the Menu bar, 

 select Option from the Setting menu, 

 select the Display tab from the Display and Settings Windows. 

Click the desired „radio button‟ to show the keypad in the Information or Queue Window.  

Select Apply which will save the selection and allow further entries or OK which will save the 

selection and return to the ez-Attendant main screen. 

 

 

 

 

Figure 3.4.1.6 Keypad Display option 

Notes: 

 It is recommended that the Keypad be displayed in the Information Window. 

 Hunt Groups can not be assigned a button in the Station Window therefore; the keypad is 

used to place a call to a station Hunt Group. 

3.4.1.7 Wake Up/Recorder Link Icon Change 

The ez-Attendant Upper Toolbar can be assigned with either a Wake Up icon or a Recorder link 

icon.  With the Wake Up icon the user can quickly set a “wake-up call‟ or alarm to an extension, 

refer to section 4.9.1.  With the Recorder icon the user can quickly activate the Conversation 

Recording application.  To employ the Recording application, the Attendant must use an LDP-

7024 or 7024LD Multi-button phone equipped with the USB option board, the ez-Attendant PC 

must have the Recording application installed and the ez-Attendant PC must be connected to the 

Multi-button phone USB port.  For operation of the Conversation Recording feature refer to the 

Recorder Application User Guide. For particulars please apply to the System sellers.  

 

As a default the ez-Attendant is configured with the Wake Up icon.  To change Wake 

Up/Recorder icon; 

 select Setting from the menu bar, 

 select Option from the Setting menu, 

 select the Display tab from the Display and Settings Windows. Figure 3.4.1.7a. 

 click the desired „radio button‟ to activate wake up icon or recording icon on Tool Up Bar. 

 select Apply or OK button to save the selection. 
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Figure 3.4.1.7a Toolbar ICON display 

 

 

 

3.4.1.7b Activated with Recorder Icon 

 

 

 

3.4.1.7c Activate with Wake Up Icon 

Notes: 

 In case of iPECS, the Recorder Icon and selection window do not supported by the system. 

 

3.4.1.8 Language Selection 

ez-Attendant can support either of two languages for the Menu, Tool bar and Window 

designations.  The default language is English.  The second language is defined as the Local 

Language which must be entered in the pcatdlls.txt file located in the ez-Attendant main 

directory, default LG-Ericsson/ez Attendant/.  Prior to selecting the Local Language, it is 

necessary to edit this file which can be accomplished with any common text file editor, MS 

Notepad, Word, etc.  The desired Local Language text is translated from the English text shown 

in this file, refer to Appendix A.  After accessing the file, you may edit the local language text. 
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The language is selected in the Language Selection section of the Display Window, Figure 

3.4.1.8.  To access this section;  

 select Setting from the Menu bar, 

 select Option from the Setting menu, 

 select the Display tab from the Display and Settings Windows. 

Click on the „radio button‟ for the language, English or Local Language. Select Apply which will 

save the selection and allow further entries or OK which will save the selection and return to the 

ez-Attendant main screen. 

 

 

 

 

Figure 3.4.1.8 Language Selection dialog box 

Notes: 

 The default Local Language is Korean. 

 Local Language words significantly longer than the English equivalent may cause unusual 

displays of the affected area.  To minimize any difficulties in the display, the Local 

Language words should be approximately the same character length as the English 

nomenclature shown in the pcatdlls.txt file of Appendix A. 

 

3.4.2 Setting Window 
 

3.4.2.1 Network Adapter Selection 

The ez Attendant user can select a preferred network adapter to log on. Some PCs have more 

than one network adapters. And ez Attendant can be operated with specific network adapter. 

To select a network adapter; 

 select Setting from the Menu bar, 

 select Option from the Setting menu, 

 select the Settings tab of the Display and Settings Windows, 

 

Using the drop down list, select the appropriate network adapter. When user select a network 

adapter, its IP address will be displayed on the following edit box. Select Apply, which will save 

the selection and allow further entries, or OK, which will save the selection and return to the ez-

Attendant main screen. 

 

 

 

 

Figure 3.4.2.1 Network Adapter Selection 
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3.4.2.2 System Setting for Logon 
 

The ez-Attendant user can select the target system type to log on. There are LDK600, LDK300, 

LDK100, LDK20 systems in LDK series. And iPECS system is the system developed based on 

IP. But using ez-Attendant, user can log on two different system without reinstallation. After 

installing the ez-Attendant , user must select proper target system to log on. 

To access this section; 

 select Setting from the Menu bar, 

 select Option from the Setting menu, 

 select the Settings tab of the Display and Settings Windows, 

 

Using the drop down selection menu, select the applicable Call Server model.  Select Apply, 

which will save the selection and allow further entries, or OK, which will save the selection and 

return to the ez-Attendant main screen. 

 

 

 

 

 

 

Figure 3.4.2.2 System setting for logon 

 

Notes: 

 The model of the host Call Server can only be changed when no user is logged on to the ez-

Attendant. 

 

3.4.2.3 Log On Information 
 

The IP Address of the host Call Server and the Attendant extension number are mandatory data 

and are assigned in the Log On Information section of the Settings Window, Figure 3.4.2.1.  

To access this section; 

 select Setting from the Menu bar, 

 select Options from the Setting menu, 

 select the Settings tab of the Display and Settings Windows, 

 

Enter the IP address of the host Call Server and the extension number of the Attendant station 

associated with ez-Attendant.  Select Apply which will save the selection and allow further 

entries or OK which will save the selection and return to the ez-Attendant main screen.   
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Fig 3.4.2.3 Log On Information in Option Window 

 

Notes: 

 The “Port” entry in the Log On Information section is the fixed UDP port used for 

communication between ez-Attendant and the Call Server. 

 ez-Attendant supports the Hot-Desk feature of the Call Server.   In this case, enter the 

appropriate Hot Desk extension number for the Attendant No in this section.  Then, to 

log-on, the Attendant must enter the associated Hot-Desk password. 

 Each ez-Attendant in an Call Server system, maximum five, must have a separate extension 

number based on the Call Server Attendant assignments (PGM 164 or 120 of the Call 

Server). 

 In case of iPECS system, the types of Attendants are system attendant and main attendant. 

The functions of ez-Attendant are different depending on this condition. 

 Use 8 digits should be checked depending on iPECS system admin. Log on can be failed 

because of the mismatch of that configuration.  

 

 

3.4.2.4 SMS Information 
 

ez-Attendant can send short text messages (48 characters) to other ez-Attendants, ez Phones, 

LG-Ericsson multi-button display telephones and LG-Ericsson DECT phone displays.  In 

addition, when ez-Attendant has access to a GSM modem, SMS (Short Message Service) to 

GSM phones can be supported.  The GSM modem can be for exclusive use of an ez-Attendant 

PC or can be shared by multiple ez-Attendants and ez Phones with a GSM modem installed in a 

„Master PC‟.  The Master will function as the SMS server.  The SMS function for GSM 

access is configured in the SMS Information section of the Setting Window, Figure 3.4.2.2a.  

The configuration includes selection of the SMS server (Master PC), the IP address of the 

Master PC (PC with the GSM modem), SMS file path and file extension.  To access the SMS 

Information section; 

 select Setting from the Menu bar, 

 select Options from the Setting menu, 

 select the Settings tab of the Display and Settings Windows, 

 

In the SMS Information section, select either the Master or Client PC box as appropriate.  For 

Client PCs, enter the IP address of the Master or SMS server PC.  For the Master PC, click on 

the Configuration button to access the Folder Setting dialog box, Figure 3.4.2.2b and enter the 
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path to the GSM modem “server/out/” files as well as the SMS file extension. 

 

 

Figure 3.4.2.4a SMS Information dialog box 

 

 

Figure 3.4.2.4b Master PC File Share Configuration Dialog Box 

 

Notes: 

 To receive SMS messages the LG-Ericsson DECT phone (Model GDC34X). 

 The “/Server/Out” path is the path to the GSM modem server/out directory; enter only that 

portion of the path leading to /server/out. 

 The “/Server/In” path is the path to the GSM modem /server/in directory; enter only that 

portion of the path leading to server/in. 

 The „Given ID Code” is used as the SMS file extension and is used by the GSM modem 

software as a validation of user. 

 

3.4.2.5 Auto Start & Auto Logon 

ez Attendant can start and logon automatically by user selection. 

User can check these options in the Program Start Option section of the Setting Window, Figure 

3.4.2.5. To select these options; 

 select Setting from the Menu bar, 

 select Option from the Setting menu, 
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 select Settings tab from the Display and Setting Windows. 

 

If Auto Start On Startup Window is selected, ez Attendant will start when user‟s PC starts. 

And if Auto Logon item is selected, ez Attendant operates logon process when it starts. 

 

 

 

Figure 3.4.2.5 Program Start Option 

 

 

3.4.2.6 Forward Information 
 

When required, the Attendant may forward calls to another Attendant or extension in the host 

system without the need to Log-Off.  The extension to receive calls is predefined in ez-

Attendant.  When activated by selecting Forward on the Lower Tool bar, all ez-Attendant calls 

are forward to the extension assigned in the Forward Information section of the Setting 

Window, Figure 3.4.2.6.  To access this section; 

 select Setting from the Menu bar, 

 select Option from the Setting menu, 

 select the Settings tab from the Display and Settings Windows. 

 

Enter the extension number to receive calls forwarded from ez-Attendant in the Forward No box.  

Select Apply, which will save the selection and allow further entries, or OK, which will save the 

selection and return to the ez-Attendant main screen. 

Figure 3.4.2.6 Forward Information  

 

Notes: 

 The ez-Attendant extension must be allowed to activate Call Forward in the host Call 

Server system database and is subject to the conditions of the Call Server. 

 

3.4.2.7 Group Setting Information 
 

When groups are defined as departments, the company name can be defined.  The company 

name is defined in the Group Setting Information section of the Setting Window, Figure 3.4.2.5.  

To access this section; 
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 select Setting from the Menu bar, 

 select Option from the Setting menu, 

 select the Settings tab from the Display and Settings Windows 

 enter the company name in the Company box. 

Figure 4.3.2.7 Group Setting Information 

 

 

3.4.3 Station Window Display Groups 
 

When the ez-Attendant is assigned to display stations by group name, see section 3.4.1.2, the 

Station Window will provide tabs at the top of the window for each group from the internal 

Phone Book.  When a tab is selected, the stations assigned to that group are displayed as shown 

in Figure 3.4.3a. Commonly, the groups are used to identify departments: Sales, Human 

Resources, Stockroom, etc.  Also, when ez-Attendant is used in a networked environment with 

the DSS/BLF Manager, special groupings are assigned for stations of network nodes. 

Figure 3.4.3a Station Window Group Tabs 

 

Display Group assignments are made in the Group Setting dialog box, Figure 3.4.3b.  To access 

this dialog box;  

 select Setting from the Menu bar, 

 select Group Setting from the Setting menu, to view the dialog box, Figure 3.4.3b. 

Station Window Group Tabs 
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Figure 3.4.3b Group Setting dialog box 

 

Groups are shown in the left window; members (system users) are shown in the right window.  

In the Group box the Group name can be entered or edited.  Group details can be expanded in 

the Group Window to show group members or hidden, displaying only the group name.  In the 

Member Window, the member names can be searched by entering characters in the Member box.  

The Member Window can be sorted by the station number or the user name by selecting the 

appropriate column header (Stn No or Name).  

 

To enter or remove a member for a group; 

 enter the group name in the Group box or select a group in the Group Window, 

 select a member name in the Member Window, 

 select      to add the selected member to the group or        to remove the member. 

 

Notes: 

 When Group Names are added or edited, the change is automatically updated in the 

internal Phone Book. 

 There is no limit to the number of groups that can be defined. 

 When networked, separate Groups are be defined for network stations.  A network group 

may contain stations from any combination of network nodes. 

 When the Group Setting dialog box is closed, Groups that have no members assigned will 

be deleted automatically. 

 

 

 

Group Edit Box Member Edit Box 

Group Window 

Member Window 
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3.4.4 Hot-Key Map Configuration 
 

The Attendant may use keyboard short-cuts or „Hot Keys‟ in place of the mouse for many ez-

Attendant call processing functions.  Hot Keys, which involve 2 keys pressed at the same time, 

are mapped to each feature under the Key Map item of the Setting menu.  

 

The default mapping is shown in Table 3.4.4. 

 

Feature Hot Keys Feature Hot Keys Feature Hot Keys 

Answer Alt + A Intrusion Alt + I Search Next Ctrl +  

Call Back Alt + B Place Call „Enter‟ Search 
Previous 

Ctrl +  

Camp On Alt + O Mute Alt + M UnPark Alt + U 

Clear Alt + X Park Alt + P Unscreened 
Transfer 

Alt + 
“Enter” 

Conference Alt + C Redial Alt + R Call Pick-up Ctrl + P 

End Alt + E Search Ctrl + “Enter” Hunt Group 
Display 

Ctrl + G 

Forward Alt + F Display Key 
Pad 

Ctrl + K CO Line 
display 

Alt + S 

Hold Alt + H Transfer Shift + “Enter” Input Account 
Code 

Alt+D 

      

 Table 3.4.4 Hot Key default Map 

To access the Hot Key mapping configuration; 

 select Setting from the menu bar, 

 select Key Map from the Setting Menu. 

 

Notes: 

 Duplicate Hot Key mapping is not allowed. 

 The Space bar and the Numeric keys can not be employed in a Hot Key map. 

 

 

3.4.5 Customize Environment 
 

Using the Customize dialog box, Figure 3.4.5, operation of the ez-Attendant may be optimized 

for the user.  There are three categories under the Customize dialog box including settings for 

Outlook, Search options and enabling call logs and trace records.  To access the Customize 

dialog box; 

 select Setting from the Menu bar, 

 select Customize from the Setting menu. 
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Figure 3.4.5 Customize Dialog box 

 

In the Outlook Setting section, select Outlook Auto Start to activate Outlook when the ez-

Attendant starts.  Outlook will be started and minimized allowing the ez-Attendant quick 

access to the Outlook database.  Schedule Auto Load will automatically update the ez-

Attendant schedule files for other users at increments in the Time box using the path entered in 

the Path box. 

 

Outlook Pop-up enables ez Attendant to display outlook pop-up window when it gets an 

incoming CO line call. If there is not CLI, ez Attendant doesn‟t display this pop-up window. 

 

The Search Order in the Search Setting section determines the order in which the ez-

Attendant will search for a phone number when the ez-Attendant user attempts to place a call 

from a Phone Book entry.  The user may search through the several ez-Attendant databases.  

The characteristics of the search are defined in Search Option of the Search Setting section.  

Characters : and Phone number can be set to perform a search for a given text/digit string in 

the search field from either the beginning of the field or contained anywhere within the field 

(sub characters).  Use the drop down selection menu to select the desired search option. 

 

The Log View Setting and Trace Setting enable or disable storing call records and trace 

records for the ez-Attendant.  Select the desired option. 
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3.4.6 External Call Dial Codes 
 

For proper operation of external calls, ez-Attendant must be assigned dial codes for CO Line 

access, International access, Local country code, etc.  These codes are input in the Code Setting 

dialog box, Figure 3.4.6.  To access this dialog box; 

 select Setting from the Menu bar, 

 select Code Setting from the Setting menu to view the Code Setting dialog box, 

 select the appropriate box and enter the local codes. 

Figure 3.4.6 Code Setting dialog box 

 

Notes: 

 The Prefix code is also called the city or office code. 
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3.5 ez Attendant PC to Host Connection 

 

ez-Attendant is connected to the host Call Server by way of the LAN (Local Area Network).  It 

is recommended that each ez-Attendant and the Call Server be connected to a 10/100 Base T 

Ethernet switch port.  The connection should use Category 5 straight through cable terminated 

in appropriate connectors, typically an RJ-45 connector, wired as shown below. 
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4 ez-Attendant Operation 
 

4.1 Operation Overview 
 

ez-Attendant is a software application designed to visualize attendant call processing and 

handling for the Call Server system.  The ez-Attendant application resides on the attendant‟s 

desk-top and is accessed by the ez-Attendant short-cut icon on the windows desktop.  Opening 

the application, the Attendant logs on, establishing the link to the Call Server over the LAN.  

The Call Server configuration, station status, and other information are downloaded. 

 

The ez-Attendant screen provides visual status of registered Call Server users in the Station 

Window with the Station Field View showing DSS/Status buttons.  These buttons provide more 

detailed information on the status of users then available from the DSS/BLF buttons and LCD of 

normal multi-button phones by employing icons to denote status: Forward, DND, etc., combined 

with station name and number information.  The alternative List View includes status icons for 

all users in a spreadsheet like list which can be viewed, edited, searched and used for placing 

calls.  

 

Incoming calls to ez-Attendant are displayed in the Queue window with Caller ID and queue 

time.  When answered, the call information is shown in the Active Call Window with additional 

information from comparison to the ez-Attendant Phone Book database.  ez-Attendant can run 

in background, allowing the Attendant to employ other PC applications for word processing, etc.  

When a call is received while “minimized”, ez-Attendant delivers the call in a pop-up window, 

the user can answer and activate the ez-Attendant screen by „clicking‟ the pop-up. 

 

Transferring the call can be as simple as „clicking‟ a button in the Station Window or, entering a 

station number or name in the search box.  Matches to the search entry displays detail from the 

Internal User Phone Book database and status from the Call Server in the Information Window.  

The Schedule Window displays schedule information for the station from a public MS Outlook 

database and any active Text Message is displayed in the System Text Message Window.  

Selecting the arrow button places a call to the selected user for transfer. 

 

On screen buttons give easy access to commonly needed Attendant features such as Park, Paging, 

Camp on, Forward, Hold, Conference, etc.  ez-Attendant affords access through the Call Server 

to send SMS (Short Message Service) messages to other system users with an LCD multi-button 

phone, LG-Ericsson DECT phone, ez-Phone or ez-Attendant.  Incorporating a GSM modem in 

the PC, ez Attendant can send and receive text messages over GSM mobile networks supporting 

SMS service.  The ez-Attendant user can select recipients from the ez-Attendant databases 

(Phone Book, Log View or System Speed Dial) or, with the Keypad pop-up window, dial a 

number for ad-hoc calling. 
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ez-Attendant gives graphical access for Attendant system control functions commonly available 

through the multi-button phone including: Day/Night ringing activation, Attendant Cancel 

control, Call Forward, DND and System Text Messaging for other users, Temporary COS 

(Phone Lock), Date/Time, Wake-Up or Conversation recording, etc.  For each control function 

a dialog box is provided, allowing ez-Attendant user input.  In addition, ez-Attendant can share, 

via the upload/download utility, the Call Server System Speed Dial database which permits the 

user to add or modify entries as well as search and place calls from the database. 

 

ez-Attendant maintains a database of External contacts which is accessed in the Station Window 

Phone Book View.  Entries in the Phone Book can be added, edited, search and used to place 

calls.  The Phone Book is stored as either an MS Access file and is linked to the user Outlook, 

Goldmine or ACT! database using the import/export Tool. 

 

ez-Attendant monitors and can log all external call activity of the Call Server as well as internal 

calls to/from the ez-Attendant.  This Log is shown in the Station Window as the Log View in 

place of the Station Field or Phone Book View.  As with other ez-Attendant databases, entries 

can be searched and used to place calls. 

 

These and other operations are detailed in the following paragraphs referencing the ez-Attendant 

screen as shown in Figure 4.1 below.  This figure provides call-outs for each of the ez-

Attendant screen windows, tool bars, etc. 
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Figure 4.1 ez-Attendant Screen 

 

4.2 Log on 
 

Before starting Log on, ez-Attendant must be the active application.  To start ez-Attendant 

„double-click‟ the ez-Attendant shortcut icon on the Windows desk-top, Figure 4.2a. 

Figure 4.2a ez-Attendant Shortcut 

 

To log on ez-Attendant, with ez-Attendant as the active screen, click the                 on the 

right side of the Upper Tool bar of the ez Attendant screen.  The log on process can also be 

started with the Log On selection in the File menu, the Log-on Process Window, Figure 4.2c, 

will appear.  

In case of iPECS system, when user tries to log on, ez Attendant may show Password input 

window like figure 4.2b. 

Active Call 
window 

Queue Call 
window 

Search Box 

Information 
window 

Station 
window 

ez-Attendant 
Menu bar Upper Tool 

bar 

Lower Tool 
bar 

SMS & Hunt 
Group window 

Station 
View Tabs 

Group 
Display Tabs 

Schedule 
window 

System Text 
Message window 
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Figure 4.2b Logon Password Input Window 

The log on process includes download of various data files and configurations from the Call 

Server and will require several minutes.  The log on process may require additional time 

depending on traffic in the Call Server and the LAN. 

Once complete, the          icon will change to allowing easy log off. 

 

Figure 4.2c Log-on Process Window 

 

If the log on process is not successful, the LogOn Fail pop-up window, Figure 4.2d will appear 

with an error message indicating the cause of failure.  Refer to Appendix B for error messages. 

Figure 4.2d LogOn Fail Error Message window 

 

When ez-Attendant is used with the Call Server Hot Desk feature, the user must follow the Hot 

Desk log on procedure.  The Hot Desk Password dialog box, Figure 4.2e, will appear for 

password entry.  When the password is correctly entered, select OK to proceed with the log on 
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process. 

Figure 4.2e Hot Desk Password dialog box 

 

4.3 Answering Incoming Calls 
 

ez-Attendant can answer calls in several ways depending on the state of the ez-Attendant 

application, active or minimized, and the extension receiving the call, ez-Attendant or another 

extension in the system. 

 

4.3.1 ez-Attendant Minimized 
 

When ez-Attendant receives an incoming call with the application minimized, the Incoming Call 

Pop-Up Window, Figure 4.3.1, will appear.  Selecting this window will answer the call and 

activate the ez-Attendant screen for further call processing.  For further call processing options 

refer to section 4.4 Attendant Call Processing. 

 

 

 

 

 

 

 

Figure 4.3.1 ez-Attendant Incoming Call Pop-Up Window 
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4.3.2 ez-Attendant Screen Active 
 

When ez-Attendant receives a call with the application active, the call information is displayed 

in the Queue Window.  Information provided depends on the Caller Id received with the call 

and may include the calling party name, number and length of time in queue. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.3.2a Incoming Call Queue Window 

Queued Call Window 

Active Call Window 
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The ez-Attendant user may answer a queued call by selecting the desired call using the mouse or 

using the Call Answer Hot Keys (default „Alt + A‟).  Using the Hot Keys will answer the 

queued call shown at the top of the Queue Window.  

 

Once answered, information on the call is moved from the Queue Window to the Active Call 

Window just above the Queue Window, Figure 4.3.2b, and audio is sent to the Attendant‟s multi-

button phone.  In addition to the Caller name, number and call duration, when CLI is provided 

and the call is from a caller registered in the Phone book, the Company name will be displayed.  

In addition, for recalls, the Active Call Window will display the origin of the recall.  

Figure 4.3.2b Active Call Window 

 

Notes: 

 Up to 20 calls can be queued to an Attendant in the Call Server. 

 If the Attendant is using another PC application when a new call arrives, the Incoming Call 

pop-up window will be displayed and can be used to activate the ez-Attendant and answer 

the call.  Refer to section 4.3.1. 

 The ez-Attendant user may answer a call in the traditional manner using the multi-button 

phone associated with ez-Attendant. 

 When a call is answered by the ez-Attendant, a cursor appears in the Search box of the ez-

Attendant main screen in preparation for the Call Transfer operation, refer to section 4.4.1. 

 

4.3.3 Call Pick-Up 
 

The ez-Attendant user can answer calls ringing at other extensions using Call Pick-Up. Tone 

ringing intercom calls, incoming CO line calls, recalling CO line calls and transferred CO line 

Active Call 

Window 
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calls may be answered using the Pick-Up feature. 

 

To answer a call using Pick-Up; 

 in the Station Window, select the extension button with the incoming call or, 

 in the Search box, enter the extension number, 

 press the Pick-Up Hot Keys (default Ctrl + P). 

 

Notes: 

 Call Pick-Up is subject to the conditions of the host Call Server system. 

 

4.4 Attendant Call Processing 
 

4.4.1 Transferring an Active Call 
 

ez-Attendant can send an active call to another extension or station group in the host Call Server 

system.  The transfer operation allows the ez-Attendant user to announce the call to the 

receiver and await a response.  This is known as “Screened Call Transfer”.  The Attendant 

need not announce or await a response, which is known as “Unscreened Call Transfer”. 

 

Calls may be Transferred using the Station Window buttons or entering search criteria in the 

Search entry box.  A match to the entry is displayed in the Information Window with user 

information as shown in Figure 4.4.1.  In addition the user‟s schedule and text messages are 

displayed in the appropriate window.  This information may be employed by the ez-Attendant 

user to more efficiently handle the call.  ez-Attendant may also access the search function by 

pressing the “F2” keyboard button which will place the cursor in the search box. 

 

If the intended receiver is busy, ez-Attendant may camp the call on the busy user, see section 

4.4.2 Camp-On, or use Intrusion, see section 4.4.3 Intrusion, to announce the call.   

 

To transfer an active call; 

 select the desired station button in the Station Window, 

 to screen the transfer, await answer and announce call, 

 select            to complete the transfer, 

Or, using the search function 

 enter the search criteria, 

 select the     button or enter the search Hot Keys (default Ctrl + “Enter”) to view match 

information, 

 to transfer the call, select the      button,  

 to screen the transfer await answer and announce call, 
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 select           to complete the transfer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.4.1  Information Window Call Transfer 

 

Notes: 

 The search function will not provide information on the status of a Hunt Group and only 

unscreened transfers can be made to a Hunt Group. 

 If multiple matches are found, the number of matches is shown and the user may review 

each match using the Search Hot Keys (default Ctrl +  for Search Previous, and Ctrl +  

for Search Next). 

 ez Attendant supports drag&drop function for queued calls so that user drag a call and 

drop the call on a specific station button in the Station window it will do transfer. 

Busy state Icon. 

Busy state Icon. 
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4.4.2 Camp-on 
 

When transferring a call to or calling a busy extension, ez-Attendant can Camp the call on the 

busy extension sending a call camp-on tone to the user. 

 

To Camp-on a call; 

 receive busy signal on an internal call, 

 press the               button below the Information Window. 

 

Notes: 

 Camp-on is subject to the conditions of the host system. 

 

4.4.3 Intrusion 
 

When calling a busy extension, ez-Attendant may Intrude into the extension user‟s conversation 

to announce an important call, etc.  Intrusion must be allowed in the host Call Server system. 

 

To Intrude on a conversation; 

 receive busy on an internal call, 

 press the               button below the Information Window. 

 

Notes: 

 Intrusion is subject to the conditions of the host system. 

 

4.4.4 Call park and retrieve 
 

ez-Attendant may place a call into a Park state where the call is on hold and internal users can 

retrieve the call by dialing the Park Zone or orbit.  This feature is often employed by an 

Attendant to Park a call and then page a user to pick-up the call from the Park Zone. 

 

To Park a call; 

 press the            button on the Lower Tool bar. 

 the call is placed on hold in the next available Park Zone and the Zone number is displayed 

in the optional Park Window, Figure 4.4.4a. 
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Figure 4.4.4a Park Window display 

 

To retrieve a Parked call; 

 activate the Keypad Window (default Ctrl K), 

 dial the Park Zone.  

   Or 

 move mouse focus to edit box in the information window by pressing keyboard ( default 

Alt U), 

 input park number and press Enter key. 

Or  

 select the desired Park Zone from the Park Window. 

Figure 4.4.4b Parked Call Access with Keypad Window 

Notes:  

 Call Park is subject to the conditions of the host system. 

 

4.4.5 Paging 
 

ez-Attendant can make announcements over the speakers of idle extensions and/or external 
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announcement speakers.  Extensions and speakers are arranged in groups called Page Zones.  

Extensions are arranged in Internal Page Zones, audio speakers are arranged in External Page 

Zones. These Page Zone information is downloaded by ez Attndant from the Call Server when 

ez Attendant logs on. 

 

In the Paging Window, Figure 4.4.5, ez-Attendant can select an individual zone, groups of zones 

or all zones to page simultaneously. 

 

To place a page announcement;  

 press the              button on the Upper Tool bar,     

 select the desired zones in the Paging Window, Figure 4.4.5, 

 make announcement into the Attendant multi-button phone handset, 

 hang-up.  

Figure 4.4.5 Page Zone dialog box 

 

Notes: 

 Paging is subject to the conditions of the host system. 

 In MG system, ez Attendant has only one speaker mode for paging option. 

 

4.5 Placing a Call 
 

The ez-Attendant user has a number of mechanisms available to place calls.  In addition to 
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placing calls in the traditional manner from the Attendant multi-button phone, outgoing calls 

from ez-Attendant can be placed using any of the Station Window tabs (Station Field, Phone 

Book and Log View) from the Search box, or from the Keypad Window. 

 

4.5.1 Station Window Station Field 
 

To place a call from the Station Field view, merely click on the desired station button or, in the 

List view, double click on the desired user record.  ez-Attendant places the call with the audio 

to the Attendant multi-button phone. 

 

 

 

 

 

 

 

Figure 4.5.1 Station Button and List View display 

 

4.5.2 Station Window Phone Book tab 
 

The Phone Book view, Figure 4.5.2, gives different views for each ez-Attendant database 

(Internal parties, External parties) and System Speed Dial numbers.  Each or all ez-Attendant 

database groups can be displayed and searched for the desired number. 

 

To place a call; 

 select the radio button for the desired view, 

 search the database using the „Enter text here‟ cell at the top of each field by entering text or 

digits, 

 double click on the field with the desired phone or Speed Dial bin number, company, home, 

etc., or 
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 double click the user name.  ez-Attendant will search the selected record for a phone 

number based on the search priority set in the Searching Order defined in the Customize 

dialog box, section 3.4.5.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.5.2 Phone Book Internal and Speed Dial fields 

 

4.5.3 Station Window Log View  
 

The Log View selects a log of external calls made or attempted by or to users of the host Call 

Server system as well as internal calls from or to the ez-Attendant.  ez-Attendant can view, 

search and select a call to any logged called or calling party. 

 

To place a call; 

 search the database using the „Enter text here‟ box at the top of each field by entering text 

or digits, 

 double click the field with the desired phone number, caller or called. 

Place calls using these fields 



ez-Attendant Issue 2.0u 

 

 38 8-Jul-10 

 

 

 

 

 

 

 

 

 

 

Figure 4.5.3 Log View fields 

 

4.5.4 Keypad Window 
 

ez-Attendant can make calls as if dialed from the Attendant‟s multi-button phone.  To place a 

call using the Keypad; 

 press the „show Keypad‟ Hot keys (default Ctrl+K), to view the Keypad Window, Figure 

4.5.4. Regarding Display and Wetting Window, refer to section 3.4.1.5 

 dial (click or keyboard) the desired number including any Line group access code required, 

 select  or Call to place the call. 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.5.4 Keypad Window 

 

Notes: 

 The conditions associated with placing a call from the Attendant‟s multi-button phone 

apply to calls made from the Keypad Window. 

 Hunt Groups can not be assigned a station button.  Thus, to call a hunt group, the ez-

Attendant must use the Keypad Window. 
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 The Keypad Window can be used to call the last ez-Attendant dialed number, „Redial‟, by 

selecting the Redial button in the Keypad Window. 

 The Clear button will remove the entire number should an error be made in the dialed 

number. 

 User must use this keypad window to make an Transit-Out call. 

 The Keypad Window can be displayed only by pressing hot key(Ctrl+K). 

 

4.6 Message Wait/Call Back 
 

When calling an extension that is busy, ez-Attendant may request a Call Back. 

 

If the extension is idle or in DND, the ez-Attendant can leave a Message Wait indication to the 

called extension. 

 

To activate Message Wait or Callback 

 call an extension, 

 if no answer, busy signal or DND signal is received, press the                 button. 

 

If the extension is busy, Call Back is activated.  When the called extension returns to idle, the 

system will notify the ez-Attendant with a Call Back.  When ez-Attendant responds to the Call 

Back, the previously busy station is called. 

 

If the called extension is idle but does not answer or is in DND, the host Call Server will activate 

Message Waiting.  When the called extension responds to the Message Wait indication, a call is 

placed to the ez-Attendant extension. 

 

Notes: 

 Message Wait/Call Back is subject to the conditions of the host system. 

 

4.7 Lower Tool bar 
 

The Lower Tool bar gives the ez-Attendant user convenient access to other call processing 

features of the host system including Hold, Conference, Call Forward, Mute and End. 

 

4.7.1 Hold Call 
 

ez-Attendant can place calls on hold.  The call will be placed on the preferred hold mode in the 

host system database.  Held calls are displayed in the Queue Window with the hold Icon, Figure 

4.7.1a.  After expiration of the Recall timer, the call recalls to ez-Attendant and the Recall Icon 

is displayed, Figure 4.7.1b. 
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To place a call on hold 

 select the           button on the Lower Tool bar or „Hold‟ Hot Keys (default Alt + H). 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.7.1a & b Hold and Recall Icons 

 

Notes: 

 Recall timers for Hold are assigned in the host Call Server system. 

 

4.7.2 Conference 
 

The ez-Attendant user can join several parties in a conference call.  A maximum of five parties 

can be joined with the ez-Attendant‟s multi-button phone in a conference.  To establish a 

Conference; 

 place first call, 

 press the              button, the first call is placed on hold, 

 place second call, 

 press the              button, the second call is placed on hold, 

 repeat process for additional parties, 

 press the              button, all parties in conference. 

 

Notes: 

 Conference is subject to the conditions of the host system. 

 

4.7.3 Call Forward 
 

ez-Attendant can activate Call Forward, forwarding all calls to a pre-defined extension.  The 

extension is assigned under the Setting menu, refer to section 3.4.2.4.  To activate Call 
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Forward from ez-Attendant; 

 select the           button on the Lower Tool bar to activate ez-Attendant Call Forward 

Or,  

 select the  on the Upper Tool bar 

 select the Forward box from the My Status dialog box, Figure 4.7.3, to activate ez-

Attendant Call Forward. 

 

 

 

 

 

 

 

 

 

Figure 4.7.3 My Status dialog box 

 

Note:  

 Call Forward is subject to the conditions of the Call Server host system. 

 

4.7.4 Mute 
 

While on an active call, ez-Attendant can mute the user‟s microphone so that the connected 

party can not hear the user.  By activating Mute, all audio transmission from the user‟s phone is 

blocked. 

 

To activate Mute; 

 select the         button on the Lower Tool bar, the ez-Attendant multi-button phone is 

muted.  

  

4.7.5 End 
 

ez-Attendant can terminate an active call by selecting the          button on the Lower Tool 

bar.  This action will terminate the call as if the handset on the multi-button phone were 

returned to the cradle. 

 

4.8 Tools Menu 
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The Tools menu allows ez-Attendant easy access to features generally programmable by the 

Attendant position including: 

Station Name 

Date and Time 

BGM source selection 

Station COS 

Temporary COS 

Pre-selected & Customized Messages. 

 

4.8.1 Station Name Change 
 

ez-Attendant can assign or change the name associated with extensions in the host Call Server 

system.  This name is displayed in the LCD of other extensions when placing or receiving a 

call from the extension. 

 

To assign an extension name; 

 select Tools from the Menu bar, 

 select Station Name from the Tools menu to view the Station Name dialog box, Figure 

4.8.1, 

 enter the desired extension number in the Station No box using the keyboard, 

 enter the name in the Station Name box using the keyboard, 

 select Apply or OK. 

Figure 4.8.1 Station Name dialog box 

 

Notes: 

 Only English is supported for the Station Name. 

 The Station Name may be up to 11 characters. 

 The Station Name is displayed with upper cases. 

 The valid characters are “a~z” , “A~Z”, “0~9”, “;.,@” and space. 
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4.8.2 Date/Time Change 
 

If required, ez-Attendant can change the host system date and time in the Date/Time dialog box.  

To access this dialog box; 

 select Tools from the Menu bar, 

 select Date/Time from the Tools menu to display the Date/Time dialog box, Figure 4.8.2, 

 select the month and date from the Calendar area, 

 select the date display mode (day/month/year or month/day/year) in the Date area, 

 enter the time and time display mode (12 or 24 hour) in the Time area, 

 select OK. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.8.2 Date/Time dialog box 

 

Notes: 

 The Date/Time assignments are for the host Call Server system and will not affect the ez-

Attendant PC. 

 

4.8.3 Text Messaging, Preselected & Custom 
 

4.8.3.1 Activating Text Messages 
 

ez-Attendant can activate the host System Text Messages (Preselected or Custom) for other 

extensions.  When activated internal callers to the extension will receive the text message in the 

LCD of their multi-button phone.  Many of the Preselected (Fixed) Messages provide for the 

entry of additional characters to specify time, date, etc. 

 

Text Messaging is activated from the Message Type Window, Figure 4.8.3.1a.  To activate Text 

Messaging; 
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 select Tools from the Menu bar, 

 select Select Message Type from the Tools menu to view the Message Type Window, 

Figure 4.8.3.1a, 

 select the desired message type tab (Preselected or Customized), 

 select the desired text message radio button or Remove Message button, 

 enter the extension range in the Station boxes, 

 select Apply or OK to activate. 

 

Figure 4.8.3.1a Message and Type Selection Window 

 

When ez-Attendant calls a station with Text Messaging active, the message will display in the 

System Text Message Window, Figure 4.8.3.1b. 
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Figure 4.8.3.1b System Text Message Window display 

Notes: 

 Text messaging is subject to the conditions of the host Call Server. 

 Selecting the Remove Button in the Message Type Window will deactivate Text Message 

forward. 

 In iPECS MG systems, ez Attendant doesn‟t have any customized message. 

4.8.3.2 Entering/Editing Customize Messages 
 

ez-Attendant can access and edit the host Call Server system‟s Customized Message table to 

enter or edit the Custom Messages.  When activated, Custom Messages are sent to the LCD of 

callers‟ multi-button phones, ez Phone user‟s screen and the ez-Attendant screen.  Custom 

Messages are edited in the Custom Message Window under the Setting menu.  To access the 

window; 

 select Setting from the Menu bar, 

 select Customized Messages from the Setting menu to view the Custom Message 

Window, Figure 4.8.3.2, 

 enter message text string using the keyboard, 

 select OK. 
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Figure 4.8.3.2 Custom Message Window 

 

Notes: 

 Text Messaging is subject to the conditions of the host Call Server system. 

 In iPECS MG systems, ez Attendant doesn‟t have this feature. 

 

4.8.4 COS 
 

4.8.4.1 Class Of Service Assignment 
 

ez-Attendant can access the host Call Server database to modify the COS (Class of Service) 

assignments of the system extensions.  COS controls the external call dialing privileges for 

extensions.  COS assignments are modified in the Change COS dialog box, Figure 4.8.4.1.  To 

access this dialog box; 

 select Tools from the Menu bar, 

 select Attendant from the Tools menu, 

 select Change COS to view the Change COS dialog box, Figure 4.8.4.1, 

 enter the desired station range in the Station Range area, 

 select the desired Day and/or Night COS desired in the COS Setting area, 

 select Apply or OK to change the COS. 
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Figure 4.8.4.1 Change COS dialog box 

 

Notes: 

 Extensions in the host Call Server are subject to the COS dialing restrictions assigned. 

 COS levels can be different depends on the host Call Server. 

 

4.8.4.2 Temporary COS (Phone Lock) 
 

Temporary COS is employed to temporarily block non-authorized outgoing external calls.  ez-

Attendant can activate Temporary COS for other extensions which assigns the extension a COS 

level of 7.  This effectively locks the phone by denying the extension the ability to access or 

dial on an outside CO Line.  Temporary COS is activated in the Temporary COS dialog box, 

Figure 4.8.4.2.  To access the Temporary COS dialog box; 

 select Tools from the Menu bar, 

 select Attendant from the Tools menu, 

 select Temporary COS to view the Temporary COS dialog box, Figure 4.8.4.2, 

 enter the desired station range in the Station Range area, 

 select COS Down (Class 7) to activate Temporary COS or COS Restore to restore the 

extension‟s normal COS level, 

 select Apply or OK. 

Figure 4.8.4.2a Temporary COS dialog box 

 

4.8.5 Attendant Cancel 
 

ez-Attendant can „cancel‟ certain features that may be active at one or more stations.  Station 

features that are deactivated by Attendant Cancel include DND (Do Not Disturb), Call Forward, 

System Text Messaging and Wake-Up call.  Attendant Cancel is located in the Attendant 
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Cancel dialog box, Figure 4.8.5.  To access the dialog box; 

 select Tools from the Menu bar, 

 select Attendant from the Tools menu, 

 select Attendant Cancel to view the Attendant Cancel dialog box, Figure 4.8.5, 

 enter the desired station range in the Station Range area, 

 select Apply or OK. 

 

 

 

 

 

 

 

 

 

Figure 4.8.5 Attendant Cancel dialog box 

 

Notes: 

 The Attendant Cancel feature is subject to the conditions of the host Call Server. 

 

4.8.6 BGM (Background Music) Selection 
 

The host Call Server may provide multiple channels or sources for BGM (Background Music) 

which is played over the speakers of idle multi-button phones.  ez-Attendant may select the 

source channel for BGM.  This selection is made in the ICM BOX BGM Selection dialog box.  

To access this dialog box; 

 select Tools from the Menu bar, 

 select Music Selection from the Tools menu, to view the ICM BOX BGM Selection dialog 

box, Figure 4.8.6, 

 select the desired channel from the pull-down selection menu in the Music Channel area, 

 select OK to change the Music Selection. 

Figure 4.8.6 ICM BOX BGM Selection dialog box 
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Notes: 

 Music channels available are dependent on the host Call Server system and installation. 

4.8.7 Conference Room Manager 
 

Ez-Attendant supports the manager for conference room. Using Conference Room Manager 

window, user can activate/deactivate a conference room.  

To access the conference room manager dialog box and set conference room; 

 select Tools from the Menu; 

 select Conference Room Manager on the Tools menu to view Conference Room 

Manager dialog, Figure 4.8.7.1 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.8.7a Conference Room Manager 

 The number 571 ~ 579 are the conference room numbers received from Call Server system. 

 The number put in parenthesis means the number of participants in the conference room.  

 To activate a conference room, user click the right mouse button on a conference room 

button; the popup menu is shown; Figure 4.8.7.2 

 

 

 

 

 

 

 

 

 

 

Figure 4.8.7b Popup menu for activating conference room 
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 When select Conference room activate menu, ez-Attendant shows Password input dialog 

box; Figure 4.8.7.3 

 

 

 

 

 

 

Figure4.8.7c Password Input Dialog for activating conference room 

 When a conference room is activated, but the participants do not join the room, ez-

Attendant can remove the room. To remove the room, click the right mouse button on a 

activated conference room button.; Figure 4.8.7.4 

 

 

 

 

 

 

 

 

 

 

Figure 4.8.7d Popup menu for deactivating conference room 

 

 

4.8.8 Authorization Code 

Authorization codes are employed to control access to the system resources and facilities. Codes 

up to 12 digits may be entered into the system database. The station has an associated Station 

Authorization bin, which can be assigned by the user from ez Attendant. The System 

Authorization codes are stored in System bins and are entered or deleted. 

To access Authorization Code function; 

 select Tools from the Menu, 

 select Authorization Code from the Tools menu,  

 ez Attendant shows the Password input window to get admin password. 

If the password is matched the Authorization Code setting window display like Fig 

4.8.8a 

 select System or Station type on the Authorization Code setting Dialog  

 after select index or station number read to get contents 
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 change password and COS values, then click Apply button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.8.8a Authorization Code 

Notes: 

The detail functions of Authorization Code can be different according to the target system. 

 

4.9 Upper Tool bar Functions 
 

4.9.1 Wakeup Call Registration/Cancel 
 

When the Upper Toolbar is assigned with the Wake Up icon,  „Wake-up call‟ or alarm can be 

set for an extension that will cause the system to ring the extension at the assigned time of day.  

The Wake-up can be a one-time event or may be repeated on a daily basis.  ez-Attendant can 

set a Wake-up time for other extensions in the system in the Wake-Up dialog box Figure 4.9.1.  

To access the Wake-Up dialog box and set a Wake-up time; 

 select the            button from the Upper Tool Bar to view the Wake-Up dialog box, 

 select the desired user from the Category area, 

 select the     button to select a user, multiple users may be selected 

or enter a extension number in the Entry box, 

 enter the desired time in the Time Setting area, 

 select the appropriate radio button in the Alarm Type area, one-time, continue or remove, 

 select Apply or OK. 
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Figure 4.9.1 Wake-Up dialog box 

Notes: 

 The maximum number of extensions that can be assigned to receive a Wake-Up signal at 

one time is based on limits of the host Call Server. 

Entry area 
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4.9.2 SMS (Short Message Service) 
 

4.9.2.1 Internal SMS 
 

ez-Attendant can send short messages, up to 48 characters to other internal system users 

equipped with a multi-button phone with display, LG-Ericsson wireless DECT phone (Model 

GDC34X) or ez-Phone.  When sent, the extension is notified of the message and the LCD or 

ez-Phone screen will display the message.  ez-Attendant can also receive short messages from 

other ez-Attendants or ez Phone users.  Internal SMS messages are sent or received in the SMS 

to Keyset Window, Figure 4.9.2.1a.  To access this window and send short messages; 

 select Tools from the Menu, 

 select SMS from the Tools menu,  

 select Private SMS from the selection menu to view the SMS to Keyset Window, Figure 

4.9.2.1a, 

 select the radio button for SMS Send Window, 

 select the desired user from the Category area, 

 select the     button to select a user, multiple users may be selected 

or enter an extension number in the Entry area box, 

 enter the text message string in the Message Text Window, 

 press the Send button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.9.2.1a SMS to Keyset Window 
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Received SMS messages are displayed in the SMS Window of the ez-Attendant main screen and 

can also be viewed in SMS to Keyset Window.  To view the SMS messages from the SMS to 

Keyset Window; 

 select the radio button for SMS Receive Window to view received messages, Figure 

4.9.2.1b, 

 use the Navigation buttons to review messages. 

 

To delete a received message in the SMS Receive Window; 

 select the desired message in the Message Text Window 

 select Delete. 

 

 

 

 

 

 

 

 

 

 

Figure 4.9.2.1b SMS to Keyset, Receive Message Window 

 

Notes: 

 Internal SMS messages can be up to 48 characters in length. 

 The ez-Attendant can store up to 10 received messages.  Additional „received messages‟ 

will automatically delete the oldest stored message. 

 

4.9.2.2 Mobile SMS 
 

ez-Attendant will support GSM SMS (Short Message Service) when properly equipped with a 

GSM modem; refer to section 3.4.2.3 SMS Information.  SMS messages can be sent to one or 

more GSM subscribers simultaneously.  An ez-Attendant user can send SMS messages through 

several means including through the Tools menu, SMS on the Upper Tool bar or directly from 

the Station Window List Display, Phone Book or Log View.  The basic steps are; enter the 

message, select a mobile subscriber and send the message. 

 

Mobile SMS is managed through the Mobile SMS Window, Figure 4.9.2.2.  To access the 

Mobile SMS Window; 

Navigation 
button 



ez-Attendant Issue 2.0u 

 

 55 8-Jul-10 

 select the  button on the Upper Tool bar, 

or select the SMS option from the Tools menu, 

or „right click” the mouse on any Station Window List Display, Phone Book, or Log View 

entry, 

 select Mobile SMS from the selection menu to view the Mobile SMS Window, Figure 

4.9.2.2, 

 if not already selected, select the desired user from the Category area,  

or enter a user name or mobile number in the Entry box, 

 select the Insert button, 

 enter the text message string in the Message Text Window, 

 press the Send button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.9.2.2 Mobile SMS Window 

 

Notes: 

 ez-Attendant must be properly configured and equipped for access to a GSM modem, refer 

to section 3.4.2.3.  

Entry area 
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4.9.2.3 Fixed Line SMS (PSTN SMS) 

ez Attendant supports Fixed Line SMS(Short Message Service) when the target system equiped 

with SMSB. SMS messages can be sent to one or more target phone numbers simultaneously.  

An ez-Attendant user can send SMS messages through the Tools menu.  The basic steps are; 

enter the message, select a subscriber phone number and send the message. 

Fixed Line SMS is managed through the Mobile SMS Window, Figure 4.9.2.3a.  To access the 

Fixed Line SMS Window; 

 select Tools from the Menu, 

 select SMS from the Tools menu,  

 select Fixed Line SMS from the selection menu to view the SMS to Keyset Window, Figure 

4.9.2.3a, 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.9.2.3a Fixed Line SMS Window – Send window 

 

 select the radio button for SMS Send Window, 

 input the desired phone number 

 click the Insert button after enter an phone number in the Entry area 

box, 

 enter the text message string in the Message Text Window, 

 press the Send button. 

Entry Area 
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Received Fixed Line SMS messages are displayed in the Fixed Line SMS Window of the ez-

Attendant main screen and can also be viewed in send Fixed Line SMS Window.  To view the 

SMS messages from the Fixed Line SMS Window; 

 select the radio button for SMS Receive Window to view received messages, Figure 

4.9.2.3b, 

 Received messages are displayed whenever user clicks an item on the receive message list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.9.2.3b Fixed Line SMS Window –Receive window 

 

Notes: 

 In case of iPECS, this function does not supported by the system. 

 In case of iPECS MG, this function doesn‟t dupported by the host Call Server. 

4.9.3 My Status Ring Mode Control 
 

ez-Attendant can control the Day/Night Ring mode of the host Call Server system, placing the 

system in the Day, Night, Weekend or Auto Ring Selection mode.  Ring assignments for the 

mode selected are then enforced by the system.  The Auto Ring Selection mode employs the 

system clock to shift from Day, Night and Weekend Ring modes based on the schedule assigned 

in the system database. 

 

The Ring mode is controlled by the ez-Attendant in the My Status dialog box, Figure 4.9.3.  To 

access this dialog box; 

 select the            button on the Upper Tool bar to view the My Status dialog box, 

 select the radio button for the desired Ring mode. 
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Figure 4.9.3 My Status dialog box 

 

Notes: 

 Ring assignments for the Day, Night and Weekend ring modes are made in the host Call 

Server system database. 

 The schedule for the Auto Ring mode is assigned in the host Call Server system Database. 

 Ring modes can be different depending on the host Call Servers. 

 

 

4.9.4 Send E-mail 
 

The ez-Attendant user may send e-mails from the ez-Attendant screen using their normal e-mail 

client.  E-mail recipients can be manually entered or selected from the Station Window List 

Display or Phone Book entries.  After selecting recipients, the user‟s normal e-mail client is 

invoked with the selected addresses entered automatically.  The user may then enter the e-mail 

text and send the mail in the normal manner.  Recipients are entered from the E-Mail Window, 

Figure 4.9.4.  To access this window; 

 select the  button from the Upper Tool bar, 

or select Send Mail from the Setting menu, 

or right click on any entry in the Station Window List Display or Phone Book with an e-

mail address, 

 select or enter the desired recipients 

 select Send to activate the e-mail client and proceed as normal for the e-mail client. 
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Figure 4.9.4 E-Mail Window 

 

Notes: 

 The ez-Attendant supports Outlook or Outlook Express as the e-mail client. 

 To improve execution speed, the e-mail client application should be running but minimized. 

 

4.10 CO Line Display window 
 

The ez-Attendant user has access to a CO Line Display pop-up window, Figure 4.10a using Hot 

Keys (default Alt + S).  In this window, ez-Attendant displays the status of all CO lines and 

permits the user to access a CO Line to answer or place external calls.  To access this window 

and answer or place a call; 

 enter the “show CO Line” Hot Keys (default Alt + S) 

 select the desired CO Line to answer the call, 

for placing a call, the Phone Number dialog box, Figure 4.10b will appear if the CO Line is idle, 

 enter the phone number, 

 press “Enter”. 

 

The ez-Attendant user can also place CO Lines In or Out-of-Service.  When Out-of-Service, 

the CO line LED will Flash rapidly at the ez-Attendant and Attendant Multi-button phone and 

the CO Line will appear busy at all other extensions.  To place a CO Line In or Out-of-Service; 

 place the mouse pointer on the desired CO Line button, Figure 4.10.c, , 

 click the right mouse button, the service state will toggle between In-Service and Out-of-

Service. 
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Figure 4.10a CO line Display Window 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.10b CO line Display Window w/Phone Number dialog box 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.10c CO line Display Window/ outgoing disable for a CO line. 
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When an internal user is talking with external party ,ez Attendant user can drop the CO Line. 

To place a CO Line drop; 

 place the mouse pointer on the desired CO Line button in used state, Figure 4.10d,  

 click the right mouse button, the popup menu will be shown. 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.10d CO line Display Window/CO Line drop 

 

Notes: 

 Access to CO Lines is subject to the host Call Server database. 

 The Tool Tip window will display when the mouse pointer is moved over a CO Line icon. 

 

4.11 Hunt Group Information Window 
 

The ez-Attendant SMS Window is shared with the Hunt Group Information Window.  The Hunt 

Group Information Window, Figure 4.11, shows the Hunt Group Number, number of incoming 

calls, and the CO Line number.  

 

To toggle between the SMS Window and the Hunt Group Information Window; 

 enter the “show Hunt Group” Hot Keys (default Ctrl + G). 
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Figure 4.11 Hunt Group Information Window] 

 

This display shows Hunt Group 620 has one incoming call on CO Line 38 and CLI will be 

shown when provided. 

Notes: 

 User can only see the queued ICM calls or CO calls on the Hunt Group Call Information 

Window. 

 In case of iPECS MG systems, this function doesn‟t supported by the host Call Server. 

 

4.12 Phone book 
 

4.12.1 Phone Book Description 
 

The ez-Attendant Phone Book gives the user an extension database, external (customer) 

database.  It also gives access to the host Call Server System Speed Dial database.  The ez-

Attendant user databases are stored in an *.mdb format.  Other database formats (Outlook, 

Excel, Goldmine and ACT!) are supported via the Import/Export utility.  The Phone Book 

database can be used with a number of other ez-Attendant features, thus an accurate timely 

database is important for efficiency. 

 

Fields in the database include the following: 

 STN (extension number) or blank for an external contact 

 First Name 

 Last Name 

 Company 

 Home (Telephone number) 

 Mobile phone number 

 Job title (Ex: manager, Engineer, etc) 

 Fax number 

 Business telephone number (Office telephone number) 

 Address 

 E-mail address 

 Nick name 
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 System Speed Dial bin number from host Call Server system 

 Department 

 Memo 

 

To access the Phone Book Window, Figure 4.12.1; 

 select the Phone Book tab in the Station Window, 

 or press “F4”. 

 

To search for a Phone Book entry; 

 enter the search text for the appropriate field in the “Enter text here” cell. 

 

To delete entry; 

 select an entry, 

 select the        button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.12.1 Phone Book Window 

 

Notes: 

 The ez-Attendant user may add (register) or edit Phone Book entries, refer to section 4.12.2 

 The “All” radio button option in the Phone Book Window applies to the internal and 

external databases and does not include the host Call Server System Speed Dial database. 
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4.12.2 Add/Edit Phone Book Entries 
 

The ez-Attendant user can add (register) or edit Phone Book entries with the Register and Edit 

dialog box, Figure 4.12.2a.  To access the Register and Edit dialog box; 

 select the Register or Edit button from the Phone Book Window, see Figure 4.12.1, to view 

the Register and Edit dialog box, Figure 4.12.2a, 

 enter data for the contact, 

 after completing entry, select Apply to save the data and continue entering data or OK to 

save the data and return to the ez-Attendant main screen. 

Figure 4.12.2a Register/Edit Phone Book Entry Window 

 

Phone numbers should be entered in the following format; 

 the number should begin with a “+” followed by the country code, 

 the country code should be followed by a space, 

 the area code should be enclosed in parenthesis. 

 

To assist the user in proper entry, the Check Phone Number dialog box can be accessed by 

double clicking on the desired entry box in the Register and Edit dialog box.  This will reveal 

the Check Phone Number dialog box, Figure 4.12.2b. 
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Figure 4.12.2b Check Phone Number dialog box 

 

Notes: 

 For proper interpretation and operation, phone numbers must be entered in the correct 

format. 

 The Speed No in the Register and Edit dialog box is the System Speed Dial bin number, if 

any, associated with the contact. 

 

4.12.3 Phone Book Database Link 
 

The Phone Book database employs the Microsoft Access format and an Import/Export facility is 

provided to employ other formats including Goldmine, ACT!, Outlook and Excel.  The 

database, ATD.mdb, must exist in the ez-Attendant folder along with the ez-Attendant 

executable file in order to view and modify the contents.  The file can be generated under the 

file menu as follows; 

 select File from the Main Menu, 

 select New DB from the File menu to generate a blank Phone Book. 

 

The process for importing or exporting the database is dependent on the type of database 

involved, Outlook, GoldMine or ACT!.  Import/Export is accomplished through the Import DB 

or Export DB items under the File menu.  To import a Microsoft Outlook contact database; 

 select File from the Menu, 

 select Import DB from the File menu, 

 select the proper file type from the Import DB menu, one of the windows as in Figure 

4.12.3a will appear, 

 select the desired contact database file from the window, if required change the path to 

locate the file. 

 

 

 

 



ez-Attendant Issue 2.0u 

 

 66 8-Jul-10 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.12.3a Contact Database window 

 

In addition to the contact database, the Outlook Schedule file can be imported manually.  

Normally, this file is downloaded periodically as described in section 3.4.5.  To import the 

schedule file manually; 

 select File from the Menu, 

 select Import DB from the File menu, 

 select Microsoft Outlook Schedule from the Import DB menu, Outlook Setting window, 

Figure 4.12.3b, will appear, 

 select the desired schedule (calendar) file from Outlook Setting Window, if required change 

the path to locate the file. 

GoldMine/ACT! Database Excel Database 

Outlook Database  

Access Database 
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Figure 4.12.3b Outlook Setting window – calendar 

 

Notes: 

 To use the Import/Export facility, the database can not be in use by another application.  

Attempts to import or export will return an Operating System error message. 

 Import or export to a GoldMine or ACT! Database file can only be accomplished if there is 

no user logged on the ez-Attendant. 

 The file extension for each file type is: 

Outlook – not shown 

GoldMine or ACT! - *.DBF 

Access - *.mdb 

Excel - *.xls 

 When importing a Microsoft Outlook Schedule, only schedules for users registered in the 

Phone Book will be imported. 

 

4.12.4 System Speed Dial Window 
 

ez-Attendant allows the user access to the host Call Server System Speed Dial database.  The 

user can download the database from the host system, add or modify entries and upload selected 

entries.  In addition the user can search the database and use entries to place calls.  To access 

the System Speed Dial database; in the Phone Book Window, select the Speed radio button to 

view the Speed Dial database, Figure 4.12.4.2a. 
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Figure 4.12.4a Speed Dial Database 

 

The database must be downloaded before it can be viewed.  To download the System Speed 

Dial database to the ez-Attendant, select the Download button.  The Call Server will send the 

System Speed Dial database to the ez-Attendant.  The transfer will require several minutes and 

will be affected by the number of Speed Dials in use, LAN and Call Server traffic, etc. 

 

During the download process ez-Attendant displays the download status and cancel button, 

Figure 4.12.4.2b.  Selecting this button during the download will terminate the download 

process. 

Figure 4.12.4b Download Status/Cancel button 

 

To add or edit an entry; 

 select the desired entry, 

 enter data in the Register/Edit area, lower section of the window, 

 select upload to send the modification to the Call Server database. 

 

To delete a System Speed Dial number; 
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 select the desired entry, 

 select Delete to delete the record. 

 

To search the database; 

 enter characters/digits in the ”Enter text here” cell, 

 

Notes: 

 Call Server supports only one download process at a time.  A second request will return 

the “You cannot do up/download now.” error message. 

 Multiple records can be selected for upload or download using “shift” or “ctrl” buttons. 

 If the data entered in the System Setting for Speed does not agree with the actual connected 

Call Server, upload/download is not allowed.  The System Setting for Speed, section 

3.4.2.3 must be corrected.  This may only be accomplished with the ez-Attendant in the 

logged off mode. 

 When user set CO type to Net, CO number should be the index of PGM 324 in which CO 

Transit Out code is programmed. 

 When user uses speed editor program to edit system speed dials, he/she cann‟t use ez 

Attendant program. 

 In case of iPECS MG systems, ez Attendant has Toll Free check box and tenancy number 

instead of CO type and CO number. 

  

4.13 Log View 
 

ez-Attendant maintains a log of all external call activity from the host Call Server.  The Log 

View data can be searched, filtered, printed, saved and records deleted.  Each Log View record 

contains the following fields: 

 Status, type of call (incoming/outgoing, internal/external) 

 Caller, caller identification 

 Called, called number 

 Date, date call was made 

 Time, time call was placed 

 Duration, duration of the call in minutes and seconds 00:00 

 Queue, duration the call rang into the Call Server system prior to answer/disconnect 

 Caller Name, name of the calling party 

 Called Name, name of the called party 

 DID, for DID calls, the dialed DID number 

 DID Name, name associated with the DID number 

 Ext/Int, External or Internal call 

 Ans/Noans, Answered or not answered 
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The Log view is selected in the Station Window by selecting the Log View tab.  

Figure 4.13 Log View Station Window 

 

To filter the Log View data 

 to assure accuracy of the database, first select the All Logs button, 

 enter a FROM and TO date, these are needed for proper search operation, 

 select filter items from list, enter phone number for Caller/Called number, if selected. 

 

To search the Log View; 

 enter text in the “Enter text here” cell, 

 

To place a call using an entry, 

 Double click on the Caller or Called entry. 
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To delete a Log View record; 

 select the desired record, 

 press “Del” button. 

 

To print a Log View; 

 select Print from the Upper Tool bar,  

Or, 

 select File on the Menu bar, 

 select Print from the File menu. 

 

Notes: 

 All external calls placed or received by the system as well as internal calls to or from the 

ez-Attendant are recorded. 

 Records in the Log View are stored in the ATD.mdb file.  When the records are saved 

using the Save as function, the records are deleted from the ATD.mdb file and stored as an 

*.xls file in the file name entered. 

 Using the File menu for print allows access to the Print Setup menu. 

 The ez-Attendant log will store up to 10,000 call records; additional records overwrite the 

oldest records. 

 

4.14 General 
 

4.14.1 Tool Tip Display 
 

When the mouse pointer is moved over an Upper or Lower Tool bar Icon, the Tool Tip Window 

will open indicating the Hot Key combination which will activate the associated feature.  

Additional information is also provided when the mouse pointer is placed over an extension 

button in the Station Window, Figure 4.14.1.  The information shown includes extension status, 

Wake-up setting, active Text message, Call forward state, and active call information.  

 

 

 

 

 

 

 

Figure 4.14.1 Tool Tip Window 
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Notes: 

 The Tool Tip Window is only provided with the button icon display views of the Station 

Window. 

 

4.14.2 Record VMIB 
 

ez-Attendant can be used to access the host system VMIB so that the user may record an OGM 

(Outgoing Message) for the Attendant extension.  This message is played to callers who are 

connected to the VMIB to leave a voice mail message for the Attendant.  Once connected to the 

VMIB, the user employs the Attendant multi-button phone handset to record the greeting 

(OGM).  To record a greeting; 

 select Setting from the Menu bar, 

 select Record VMIB from the Setting menu, 

 with the multi-button phone handset, record the greeting. 

 

In iPECS-MG system, ez Attendant displays current VMIB‟s status to user. From the VMIB 

status, user can record the greeting to a appropriate empty slot number. 

To record a greeting; 

 select Setting from the Menu bar, 

 select Record VMIB from the Setting menu to see following dialog window, 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.14.2 VMIB Record Dialog 
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 Select a slot number and select Read button to see current greeting information on the 

selected VMIB. 

 Select an item in the greeting info list view and press Record button to record voice. 

 

 

 

 

 

 

 

 

 

Figure 4.14.3 Greeting Recording Dialog  

 Select Record Type and press Start Record button. 

Notes: 

 In case of iPECS, Recording VMIB function is supported by only the system attendant. 

 

4.14.3 Multiple ez-Attendants 
 

The Call Server can support up to 5 ez-Attendants which are assigned in the Attendant Group or 

ICM Tenant Group programs of the Call Server, PGMs 164 and 120 respectively.  When 

multiple Attendants are assigned, separate ez-Attendants can be logged on to each Attendant 

extension assigned in the host database. 

 

Notes: 

 The maximum number of Attendant positions and thus ez-Attendants is 5. 

 In case of iPECS, the system does not support attendant of ICM tennancy group. 

 

4.14.4 Flexible Button Programming 
 

Using the Setting menu, the ez-Attendant user can assign functions to the Flex buttons of multi-

button phones connected to the Call Server system.  Flex button assignment is similar to the 

Call Server Admin Program 115 and is managed in the Flex Buttons Setting dialog box, Figure 

4.14.4a.  To assign Flex buttons; 

 select Setting from the Main Menu, 

 select Flex Buttons Setting from the Setting menu to view the dialog box, Figure 4.14.4a, 

 enter the desired Station Range, 

 select Read to download the Flex button data, 
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 select the desired Flex Button, 

 select Setting to view the Flex Button assignment dialog box, Figure 4.14.4b, 

 enter the button Type from the drop selection menu, 

 enter any required Data required for the button type assigned, 

 select Apply or OK, to store the new data. 

Figure 4.14.4a Flex Buttons Setting dialog box 

 

Figure 4.14.4b Flex Button assignment 
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Notes:  

 The Flex button data shown in the Flex Buttons Setting dialog box is representative of the 

lowest station number in the range entered. 

 The conditions of the Call Server system apply to Flex Button assignments by the ez-

Attendant. 

 In case of iPECS MG systems, Contents of Flex Button assignment are different from those 

of the other systems. 

 

4.14.5 Networking & BLF Manager Integration 
 

ez-Attendant can operate in a network environment where multiple Call Server systems are 

interconnected over an IP network.  When the BLF manager is also installed and connected to 

the LAN with ez-Attendant and the local Call Server, ez-Attendant can monitor and display the 

status of stations connected to the remote systems as well as the local Call Server.  In this case, 

ez-Attendant will treat the networked stations registered in the ez-Attendant Phone Book as any 

other locally connected station.  

 

ez-Attendant may also call unregistered networked stations by including “n” as a prefix to the 

networked station number when using the Search box to place the call. 

 

Networked stations may also be assigned to a „network group‟.  A network group is assigned 

under the Group Setting dialog box with the prefix “N_”, refer to section 3.4.3.  For example, a 

network group would be assigned the group name “N_Labs”, as shown in Figure 4.14.5.  Any 

networked station can then be assigned to the network group including stations from different 

nodes of the network. 

Figure 4.14.5 Network station group 

  

Notes: 

 A maximum of 50 stations for each network node can be registered in ez-Attendant. 

 The BLF manager provides an idle status to ez-Attendant when a registered network station 

is ringing. 

 The BLF manager must be operated on a server other than the ez-Attendant PC. 
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4.15 Alarm information window 
 

Alarms from the host Call Server are sent as a pop-up, Figure 4.15, to ez-Attendant as well as 

the LCD of the Attendant multi-button phone.  The various Alarm messages are given in 

Appendix C. 

Figure 4.15 Alarm Information Window 

 

When received, the ez-Attendant user may send the Alarm message to another extension or 

Mobile user as an SMS message. 

 

Note: 

 Alarm messages are subject to the conditions of the host Call Server system. 

 

4.16 Prepaid call 
 

The ez-Attendant incorporates PrePaid calling services, guests can pre-pay for calling services 

from the guest station.  As calls are placed, the guest station account is reduced based on the 

call costing algorythms of the Call Server system.  At expiration of the account, the station‟s 

external calling capabilities are terminated, COS 7 is applied.  If the account expires during a 

conversation, warning tone is received and the call terminated.  The ez-Attendant has control of 

the guest station account.  To open or edit a guest account; 

 select Tools from the Main Menu, 

 select Prepaid Call from Tools menu to view dialog box, Figure 4.16, 

 enter the desired station Range, 

 select Read to download the guest station account data, 

 enter/edit the guest station account credit in the PrePaid Money box, 

 select Apply, to store the new data, or Cancel to exit the account. 
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Figure 4.16 Prepaid Call Window 

 

Note: 

 The Guest Account can have maximum credit to the account of 999999 units based on the 

Call Server costing algorythms in “PrePaid Money”. 

 In case of iPECS, this function does not supported by the system. 

 

4.17 Input Account Code 
 

While on an outside call, user can enter a series of digits that will be included in SMDR call 

record.  This Account Code, which can be up to 12 digits, can be used to allocate cost or time 

for the call. To enter an Account Code; 

 press the „Input Account Code‟ Hot keys (default ALT D),to view the Input Account Code 

dialog. Figure 4.17, 

 enter the Account code (up to 12 digits), 

 press “Enter” to send the Account Code to the system. 

 

Figure 4.17 Account Code Window 

 

Note: 

 The number of maximum digits in an Account Code is 12. 

 In case of iPECS MG, this function doesn‟t supported by the host Call Server. 

 

5 Shared MS Outlook Schedules 
 

5.1 General 
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ez-Attendant can display the schedules of registered users maintained in a shared Outlook 

database.  The Outlook database must be located in an Exchange server.  The schedule 

information is shown in the Schedule Window when a user name is input in the Search box on 

the ez-Attendant main screen and selects the Search icon, Figure 5. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.1 User Schedule display 

 

The shared database can be imported to the ez-Attendant database manually as described in 

section 4.12.3 or the database may be imported automatically on a periodic basis based on the 

settings as described in section 3.4.5.  In either case, all schedules in the path defined will be 

imported for all registered users for both attendees and hosts. 

 

5.2 Outlook set-up in Exchange Server 
 

To operate properly, users must maintain schedules in a Public folder in an Exchange Server.  

The following provides one possible scenario for set-up of the Outlook Public folders in the 

Exchange server.  

 run MS Outlook program,  

 create a folder named “Schedulers” to contain appointments, Figure 5.2a and 5.2b, 
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Figure 5.2a Schedulers Folder 

 

Figure 5.2b Create New Folder 

     



ez-Attendant Issue 2.0u 

 

 80 8-Jul-10 

 under the schedulers folder, create folders for each user. 

 

After creating folders for each user, the Schedulers folder tree will appear as in Figure 5.2c 

Figure 5.2c Schedulers Tree 

 

 

6 Hotel Function 
 

6.1 Hotel Suite room feature 
 

ez-Attendant can display only master station number in Station Window when suite room group 

is configured. Member stations do not show for easy management. In Queue and Active call 

Window, member stations calls is changed to master station number. Also in Log View, 

Incoming and outgoing call history of member stations is changed to master station number.  

Suite room information can be received only Log on time from system. If you change suite room 

group information in system admin, ez-Attendant should be log off and log on again.  

 

6.2 Hotel Room status 
 

Hotel room status can be check-in or check-out. If a room is check-out, check-out icon is 
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displayed in Station Window as in Figure 6.2a. 

 

Figure 6.2a Check-out Icon 
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Appendix A  Local Language, pcatdlls.txt file 
 

Below is a view of the text file used for display of menus, tool bars, etc.  Using a text editor, a  

Local Language can be supported by a ez Attendant‟s user. 
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Appendix B  Log on Error Messages 
 

The following messages may appear should the log on process, section 4.2, fail. 

 

No Lock key for ez-Attendant. Please Contact to your local dealer! 

LDK System is initializing. 

Same attendant number already logged on by another one. 

ATD port is no more available: There is no available attendant. All attendants are logged on. 

The number sent is not valid ATD number: Check the PGM 164 

"This agent attendant is not logon to dummy station."-> the station to use agent attendant is not 

logged on. 

"This dummy station can not be logon to the system." The dummy station number cannot be log 

on. 
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Appendix C  Alarm Messages 
 

The following messages may appear should an error occur in the host Call Server system, 

section 4.15. 

 

"Station capacity overflow!!" 

"CO Line capacity overflow!!" 

"Hiway / time slot full!!" 

"DCOB fault at xx slot number"   

"SMDR full!!"   

"DVU memory full warning!!" 

"VM memory full warning!!" 

"DTMF Receiver time slot full!!" 

“Bath alarm!!!”  

"Unknown Error occured. Please check system!!"
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Appendix D  ez-Attendant Icons 
 

Station Window Icons:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Queue Window Icons: 

 

 

 

                                       

  

 

 

 

 

 

 

 

CO Line Status Icons: 

     

 

Pre-selected Message, 

(Button Icon only) 

DKTU-Busy (blue) DKTU-Idle (white) 

SLT-Busy (blue) SLT-Idle (white) 

WHTU-Busy (blue) WHTU-Idle (white) 

DND State Forward State 

Network STN-Busy (blue) Network STN-Idle (white) 

Network STN-DND 

ICM Incoming (yellow) CO Incoming (green) 

Attendant Recall (red) Hold Recall (green) 

Park Recall (orange) 

Park Hold State 

Transfer Recall (blue) 

Invalid CO line 

Busy CO line 

Idle CO line 

Transfer hold CO line 
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Appendix E GSM Modem Integration 
 

ez Attendant supports sending or receiving of SMS by GSM modem. 

To use this function, user must have GSM modem that distributed by Innocom Company. 

Each GSM modem distributed by Innocom has a PC application to send SMS directly. 

About GSM modem, please refer to the http://www.innocom.de/English/index.htm 

The usage of GSM modem in ez Attendant is following; 

 

1. Install “PC Message –SI” program supplied by Innocom to connect GSM modem. 

This program can be distributed CD or by other ways. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure E.1 PC Message-SI Install Files 

http://www.innocom.de/English/index.htm
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2. When user clicks “setup.exe” on this folder then setup starts. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure E.2 PC-Message SI program setup start 

3. click OK button to progress setup. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure E.3 PC-Message SI program select setup folder 
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4. After select setup folder, register “program group” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure E.4. PC-Message SI –registration program group 

5. After finish installation of PC-Message SI, user can run this program. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure E.5 The location of PC-Message SI program on start menu 
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6. The main window of the PC-Message SI program is like this 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure E.6 PC-Message SI – main window 

 

7. Before using this program , it needs to be configured such as SIM card number, COM 

port and so forth. 

  

 

 

 

 

 

 

 

 

 

 

 

 

Figure E.7 PC-Message SI – Configuration window 
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8. After this configuration, input the “In” and “Out” path to read or write SMS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure E.8 PC-Message SI – Directory settings 

9. After configuration about PC-Message SI program, user must configure of the ez 

Attendant. About configuration of ez Attendant , please refer to the chapter 3.4.2.2 on 

this manual. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure E.9 ez Attendant Setting – SMS information 
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Appendix F iPECS-MG systems’ distinction 
 

ez Attendant supports iPECS-MG systems and they are different from other existing call servers. 

iPECS-MG systems use Directory Number(DN), which is the telephone number for each 

internal user. It can be used exclusively by only on station or can be shared by multiple stations. 

The basic idea of providing DN feature is not only to assign one telephone number to one 

physical telephone, but also to allow one telephone number to be shared and used by multiple 

physical stations. One physical telephone can have multiple DN so that the user has multi 

telephone numbers that can be used for outgoing and incoming calls. 

 

The station window of ez Attendant displays physical stations on its view window so there 

should be a way to display DN for each physical station. 

Each station button displays Prime-DN on its window and if user click the station button, it 

displays a list window which has DNs as follows: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Figure F.1 ez Attendant DN list window on Station window 

 

The icons displayed on DN list window are; 

 

 Busy (all status except DND and Idle states) 

 DND 

 Idle 
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DN list window can be displayed on Station window(button type), Station List window, and  

Phonebook window. ez Attendant only support Make Call and Answer Call functions on DN list 

window. 

 

PhoneBook data can only have My-DN number for its station number field. If user input same 

DN for two or more records, it causes a problem when ez Attendant searches information from 

Phonebook database. 

 

Note: 

 You should refer to the manual for iPECS-MG systems regarding Terms of DN. 

 

 


